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System Access Questions 

When should I start using Workday for tracking time? 
For new hires, you should use the system upon completion of your onboarding tasks to record time. 

Check with your immediate supervisor for details.  

For existing staff, access to the system will be available beginning on July 1st, 2018.  Human Resource 

Partners (HRP’s) should let all staff know to use Workday to record all time and absence functions 

immediately.  

Return to Top 

When should I stop using UC Time?  
All users should begin to use the new Workday system to record time beginning on July 1st, 2018. The 

final biweekly pay period, June 17-30, must be submitted and approved in UChicago Time by July 2, as 

that pay period exists within the UChicago Time system, not Workday. 

Return to Top 

How can I find out who my Time Approver is? 
You can view who your time approver and HR Partner is by accessing a report located on the Time or 

Time Off worklet. Simply click on the worklet, and under the View section, click on the report titled: 

RPT-Worker’s Time Approver and HR Partner. A chart will display with information including your 

Position, Supervisory Organization, Time Approver and HR Partner.  

Workers with multiple positions will see the Time Approver and HR Partner listed line by line next to 

each position.  

Return to Top 

What if my work schedule in the system is not correct?  
Report any problems in your work schedule to your time approver, supervisor, or HR Partner.  Your 

approver will have the ability to correct your schedule. Meanwhile, continue to clock your work hours as 

normal. 

Return to Top 

Can Workday notification emails be sent to a different Microsoft Outlook folder rather 

than my inbox? 
Workday notification emails can only be sent to the worker for whom it is intended, however, they 

come from distinct email addresses which can be moved to a specified folder instead of your inbox using 

an Outlook rule. 

 

In Microsoft Outlook, first create the folder to which you want to move the Workday notification emails, 

if you have not done so already.  
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Click the File menu, and click on Manage Rules & Alerts, then New Rule.  The rules wizard window will 

pop up, where you will select Check messages when they arrive listed under start from a blank rule 

near the bottom.  Then click the Next button at the bottom of the screen.  Under Select Condition(s), 

click the check box for from people or a distribution list. 

 

Under Step 2, click the underlined people or distribution list in the bottom field and enter 

(uchicago@workday.com) in the “From” field near the bottom.  To ensure that you only forward the 

automated summary messages (absence approvals and other notifications), you may want to also filter, 

under 'Step 1', by subject. By adding the filter, only automated summary messages will be moved. 

 

Select Next, and the check box for Move it to the specified folder, and click the underlined specified link 

in the lower field to select the folder to which you wish to forward these types of messages.  Select 

Next, and enter any exceptions on the next screen.  If there are none, click Finish.  Make sure the check 

box next to your new rule is selected, and click Ok to activate your new rule. 

Return to Top 

What do I do if I have extra qualifiers in my email address (e.g. cnet@bsd.uchicago.edu or 

cnet@surgery.uchicago.edu) and I need to forward my email? 
Go here to access the “My Account” page where you can forward to your cnet@uchicago email if your 

current email has extra qualifiers. 

Return to Top 

What should I do if emails received from Workday are going to my junk mail? 
If you are using Microsoft Outlook:  

Open your Junk Mail Folder. Select an email sent from Workday. Select Actions on the top left of the 

screen and select Junk Email. Select Add Sender to Safe Senders List and click OK on the notification 

box.  

Return to Top 

Can I customize notifications within Workday? 
Yes, you can access the profile icon and click on My Account, and then choose Change Preferences. You 

will able to adjust the frequency of notifications through this screen.  

Return to Top 

Which internet browser versions are supported? 
Chrome, Firefox, Microsoft Edge, Safari, Opera, and the BlackBerry Browser all update automatically, 

and Workday runs best on the latest version. While Workday may function on earlier versions, users 

may encounter performance issues. Users who prefer one of these browsers should make sure their 

browser software is always up-to-date. 

https://cnet.uchicago.edu/forwarding
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For Internet Explorer, users should make sure that they are using IE 11. Earlier versions are not 

supported. 

Return to Top 

Why was I able to login but then received a 'page cannot be displayed' message? 
When there is latency on the connection to Workday, this may occasionally cause you to see a "page 

cannot be displayed" warning.  To resolve this issue, log out and log back in to Workday.   

Note:  You may need to log out and log back in more than once to access the system.   

Return to Top 

Time Tracking Questions  

What if my system is down and I can't login to Workday? 
If you cannot access the Web Clock, report the problem immediately to your time approver and keep 

track of your hours on paper.  When the system becomes available, report any hours that were not 

clocked to your time approver.  Your time approver can insert your un-clocked work hours into your 

record to ensure you will be paid. 

Return to Top 

What if I forget to clock in or out? 
If you forget to clock in or out, report your work hours for that day to your time approver so that they 

can correct your time entry. Your time must be submitted in order for you to be paid correctly. 

Return to Top 

Will there still be a 6 min grace period? 
Yes, it is addressed as rounding in the Workday system. If you clock in within 6 min, time will be rounded 

to the workers default schedule. If time is clocked outside of the 6 minute grace period, Workday will 

not round the time, but stamp the actual clocked time. 

Return to Top 

Can I clock in or out from a place other than my work station? 
Clocking in or out from a location other than your work station without permission from your supervisor 

is a form of falsification.  For further clarification reference The University of Chicago Personnel Policy 

Guidelines and/or your respective collective bargaining agreement. 

Return to Top 

What if my approver does not check my timesheet before it goes to Payroll? 
Policy requires that all of your time records be reviewed and approved. If your approver does not check 

your timesheet before the time is reported to Payroll, your approver should work with your local HR 

Partner to approve your records and make any adjustments to errors on your time record. Adjustments 

to pay resulting from errors in Workday will be reflected in a later paycheck. 

http://hrservices.uchicago.edu/fpg/policies/index.shtml
http://hrservices.uchicago.edu/fpg/policies/index.shtml
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How do I set the Workday login page as my homepage? 
Internet Explorer  

 Go to https://workday.uchicago.edu/  

 At the top of the IE window, click the Tools menu.  

 Click Internet Options. 

 On the General tab, click the Use Current button.  This will make the Workday login page your 

home page 

Firefox 

 Go to https://workday.uchicago.edu/  

 At the top of the Firefox window, click on the Tools menu. 

 Select Options. 

 Click on Use Current Page.  This will make the Workday login page your home page. 

Safari for Mac OS 

 Pull down the Safari settings menu and select Preferences. 

 On the General tab, find the Home page URL and click the Set to Current Page button. 

 Click the red Close button along the top of the preferences dialog. 

 Close and open Safari.  You should see your new home page. 

Return to Top 

After setting the Workday login page as my homepage, how do I make the login page 

appear at the startup of my PC? 
 Click on your computer's Start menu button. 

 Go to All Programs and locate the Startup link. 

 Right click the link and select Explore.  The Startup folder will appear. 

 Locate the link for your internet browser, right click the link, and select Copy. 

 Paste the link to the browser in the Startup folder. 

 You can now close the folder.  Next time you startup your computer, the internet browser will 

start automatically. 

Return to Top 

How do I set up a recurring reminder in Outlook to alert me when the payroll period ends? 
Workday allows you to review the pay period dates when viewing the time calendar. Within the Time 

worklet, click on “This Week” located under the Enter Time column. The calendar page will display. The 

Time Period Lockout and Pay Date block will be listed in the first half of the screen and should display 

the respective pay period dates.  

In order to create a recurring reminder in Outlook, follow the steps listed below: 

https://workday.uchicago.edu/
https://workday.uchicago.edu/
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1. Open Microsoft Outlook and go to the Calendar. 

2. Double click on the Monday of the payroll end date. If you would like to confirm the last payroll 

date, go to https://finserv.uchicago.edu/payroll/index.shtml and scroll to the bottom of the 

page to the PDF titled “Paydates YYYY”.  Look towards the top of the web page. This is the last 

payroll end date. 

3. Populate Subject line; we recommend ‘enter or modify time for the previous pay period’ and 

select a time convenient time in the morning before the records are locked at noon. 

4. Click on the Recurrence button on the top of the screen and put 2 in the ‘Recurrence Pattern’ 

section to make it to read "Recur every 2 weeks." Click on OK.  

5. If you would like the reminder to only occur for a certain period of time, use the radio buttons to 

detail expiration after ‘x’ number of occurrences or until ‘x’ date in the ‘Recurrence Pattern’ 

section. 

6. Click on the Save & Close button and you have successfully set up a reminder to alert you every 

two weeks to enter or modify your time. 

Return to Top 

Am I able to suppress notifications in Workday? 
No – if you hold the Time Approver role, and someone in your supervisory organization submits time, 

that task will go to your inbox. The only way to stop it is to remove the role from the person in Workday. 

Return to Top 

Absence Management Questions  

What should I do if I am close to my cap for accruals? 
Workers should be reporting their absences in a timely manner and work with their manager to see if 

any time off can be taken. Please refer to the HR Policy for more information: 

https://humanresources.uchicago.edu/fpg/policies/index.shtml  

Return to Top 

Where did you get the starting balance for my accruals in Workday? 
When your department went live with Workday, these balances were loaded into Workday (the 

University's official source of record) and are used as a starting point for all accrual balances from that 

date forward. 

Information regarding accruals can be found at the following links:  

Vacation Policy  

Personal Holiday Policy  

Sick Leave Policy  

Note: Workers represented by a union will need to refer to their appropriate bargaining unit contract for 

information regarding accruals.   

https://finserv.uchicago.edu/payroll/index.shtml
https://humanresources.uchicago.edu/fpg/policies/index.shtml
http://hrservices.uchicago.edu/fpg/policies/500/p509.shtml
http://hrservices.uchicago.edu/fpg/policies/500/p511.shtml
http://hrservices.uchicago.edu/fpg/policies/500/p512.shtml
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All Monthly Confirmation Reports need to be submitted by the last working day of the month. If you are 

near the upper limit for vacation time accruals, any unrecorded vacation time by the end of the month 

could result in loss of accruals.  

Return to Top  

Why do my accrual balances look different in Workday than what I am used to seeing? 
Instead of viewing your accruals in the hour and minute format, Workday displays accrual time as 

decimals.  

For example: 

UC Time Example: 

 Worker X is eligible for ten sick days per year 

 Worker with 7.5 work hours per day will get 75 hours of sick time in a year.  

 75 divided by 12 months of the year is 6.25 hours every month.   

 6.25 hours converted into actual time amounts would be equal to 6 hours and 15 minutes or 

6:15 in an HH:MM format.  

Workday: 

 Worker X is eligible for ten sick days per year: 

 Worker with 7.5 work hours per day will get 75 hours of sick time in a year.  

 75 divided by 12 months of the year is equal to 6.25 hours every month. 

Disclaimer: This example is meant to represent the difference in format types for hours and minutes 

conversion and is in no way indicative of what you as a worker are eligible to receive. 

Return to Top 

Where do I see my accruals? 
In Workday, there are several areas to view your time off balance, or accruals. You can view a report of 

your time off balance along with the cap for each time off type. To access this report: 

 Click on the Time Off worklet 

 Under the “View” section, click on RPT- Time Off Balance with Cap 

 To see the available balances as of a specific date, enter in the date on the next screen and click 

OK.  

The Time Off balance chart will now display with the accrual amounts for each time type in one column, 

along with the capped amount for each type in another. For staff workers, you can also view your 

accruals on the Time Off worklet. View the section at the bottom titled Available Balance as of Today. 



                                                                               Time and Absence Training Resources FAQ 

Return to Top 

How are my accruals calculated? 
Accruals in Workday are calculated in decimals.  For example, if you work 7.5 hours a day and are 

eligible for three weeks of vacation a year, you will be awarded 9.375 vacation hours per month. Accrual 

formulas are based on University accrual policy (see following links for policy detail). 

Vacation Policy  

Personal Holiday Policy  

Sick Leave Policy  

Note: Workers represented by a union will need to refer to their appropriate bargaining unit contract 

regarding policy detail.   

Return to Top 

Can workers forecast future accruals? 
Workers can request this information from their Time Approvers who will have access to the Forecasting 

Absence Report which uses the prior month balance to provide a forecast of a worker’s accrual over the 

course of a period.  This report will not include any requested future time off for the worker.   

Return to Top 

Can workers view the max amount of time accrued?  
Users can click on the Time or Time Off worklet to view the Time Off Balance with Cap report. This 

report will display the time off balance, along with the capped amount that can be accrued for each time 

off plan.  

Return to Top 

Can workers request unpaid time off? 
Yes, workers can request unpaid time off by going to the Time Off worklet and reporting an absence. 

They need to select the Unpaid Time Off selection in the Type field.  

Return to Top 

How do I record unpaid absences? 
 Click on the Time Off worklet 

 Under the “Request” section, click Time Off 

 On the calendar display, click on the individual dates that you are reporting as absences. The 

selected calendar dates will turn blue. 

 Click the green button titled “Request Time Off” located in the bottom left-hand corner of the 

screen. The button will automatically calculate the number of days selected 

 Choose Unpaid Time Off in the Type field, and enter the Daily Quantity field with the number of 

hours you are reporting as absences. For multiple days, indicate the daily quantity instead of the 

total work hours 

http://hrservices.uchicago.edu/fpg/policies/500/p509.shtml
http://hrservices.uchicago.edu/fpg/policies/500/p511.shtml
http://hrservices.uchicago.edu/fpg/policies/500/p512.shtml
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 Click Submit and the request will be sent to your time approver. Please refer to the Quick 

Reference Guides (QRG’s) located at workday.uchicago.edu for step by step instructions.  

Return to Top 

Can workers request time off for past and future dates? 
Yes, Workday will accept reported past and future absences. Workers can schedule time off in the future 

as long as they have the available balance in their accruals for the absence type being requested. 

Absences can be backdates, future-dated, or current.  

Return to Top  

How will a worker know what the cap on their accruals are? 
A report titled Time Off Balance with Cap will be available to workers on the Time Off worklet. This 

report will display the respective time off plans, the Time Off Balance, and the maximum accrual amount 

for each plan. For information regarding accrual amounts, please refer to the time off policy located at: 

https://humanresources.uchicago.edu/fpg/policies/index.shtml  

Return to Top  

Will I lose my accruals if I do not submit my vacation time off request in the same month it 

actually occurred? 
No, if you are at your capped amount and submit past absences, Workday will dynamically adjust your 

accrual balance.  

For example: 

 I have 168.75 vacation hours and submit an absence request on March 20th for 7.5 hours 

o In prior state in UC Time, my current accruals would go down to 161.25, despite the fact 

that I have accrued additional time since then. 

o With the Workday deployment, my current accruals stay at 168.75, since I have accrued 

an additional 7.5 hours since that date. 

Disclaimer: This example is meant to represent the difference in format types for hours and minutes 

conversion and is in no way indicative of what you as a worker are eligible to receive.  

Return to Top  

Time Approver Questions 

If a person clocks in early or late, am I permitted to change the time to fit the worker's 

schedule? 
A worker must be paid for any time worked.  By law, you should not subtract time from a worker's 

record.  You can always add time if a worker forgot to check in, as long as you know the worker was at 

work during that time. 

Return to Top 

https://humanresources.uchicago.edu/fpg/policies/index.shtml
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When the office closes early for a holiday or other special event, will I have to manually 

change all of the workers' time or is there a way to globally change the time for a 

department? 
Since workers are on many different schedules, inserting time off would only work correctly for part of 

the department.  After receiving appropriate approval, you could instruct workers to clock out when 

they leave (or come in late, in a weather related case, for instance).    

You can enter time off for each worker in these circumstances by reporting time off for the designated 

time, and choosing the time type as Other Absences- Paid. This will allow the worker to be paid in these 

special circumstances. You can also direct each worker to report this time on their own instead of 

reporting individual time off for every worker.  

Return to Top 

How do I manually enter 24 hours on my worker's timesheet? 
Time Approvers would need to enter two separate time blocks to represent a 24 hour period on the 

worker’s timesheet.  

For example: If a worker’s shift is scheduled from 7:00am till 7:00am on the following day, two separate 

time blocks will need be created. An example of how the time blocks will be created may be as follows: 

 One time block for 7:00am-7:00pm 

 A second time block for 7:00pm-7:00am on the following day 

Disclaimer 

All workers will be paid one and one-half (1.5) times the basic straight-time hourly rate plus any 

applicable shift premium for all hours worked as directed by supervision in excess of forty (40) in one 

workweek. 

Return to Top 

What is the deadline for approving timesheets? 
The deadline for approving timesheets is noon on the Monday following the end of the pay period. 

Workers can check their timesheets to view the time period lockout dates to be aware of when the 

current payroll closing occurs. A copy of the latest Payroll calendar can also be found here: 

http://finserv.uchicago.edu/payroll/index.shtml  

Return to Top 

How do I remove requested time off that has been approved? 
There are two ways to correct time off requests depending on whether the request is approved or not. 

If the request is not approved: Workers will have the ability to view their pending time off requests and 

click Cancel This Request on the time block of the submitted absence. This will remove the requested 

time off. For more information, refer to the Cancel Time Off Request Quick Reference Guide for details 

on completing this process.  

http://finserv.uchicago.edu/payroll/index.shtml
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If the request is approved: Only Time Approvers will have the ability to correct time off requests that 

have been approved. Time Approvers can open up the time off request using the Correct Time Off 

button located on the Team Time Off worklet. After selecting the appropriate worker, the time approver 

will open up the approved request, and remove the row with the listed absence.  For more information, 

Time Approvers can refer to the Correct Time Off for Worker Quick Reference Guide for details on 

completing this process.  

Return to Top 

Can you enter time on behalf of a worker for past pay periods? 
You will be able to enter time on behalf of workers for past pay period. However, please keep in mind 

that you will only be able to go as far back as July 1st, 2018 which is the date of the Workday 

deployment.  

Return to Top 

If there are multiple time approvers for a workers, will the submitted time entries route to 

all time approvers? 
Yes, all submitted entries will route to the time approvers assigned in the system.  

Return to Top 

Report Questions 

What reports are available to Time Approvers? 
Various reports will be accessible through the Time and Time Off worklets. Additional reports for Time 

Approvers and HRP’s will be listed under the Team Time and Team Time Off worklets. A full list of 

available reports can be found here 

Return to Top 

Will forecasting accrual reports be available? 
The Forecasting Absence Report will be available to time approvers. This report will show data on the 

worker’s prior month balance, accruals earned, available balance, and the max balance across time 

periods for the remainder of the year.  

Return to Top  

Additional Questions 

Can HRP’s enter and/or correct time off on behalf of a worker? 
HRP’s have the same functionality as a Time Approver where they can enter, view, and correct time off 

on behalf of a worker. The HRP can access the Team Time Off worklet and choose the Correct Time Off 

button to make any changes to submitted requests for time off.  

Return to Top 

https://uchicago.box.com/s/sb7k7swz383xec6vt8z6clxhrr8u6a30
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Can HRP’s enter and/or correct worked time on behalf of a worker? 
HRP’s have the capability to add/correct worked time. They can access this by clicking on the Team Time 

worklet, and choose the Review Time selection to correct time. They can also add worked time by 

clicking Enter Time for Worker. HRP’s cannot however, adjust accruals and cannot approve time off if 

they are not the workers designated Time Approver.  

Return to Top 

Can workers correct time? 
Workers who are designated timesheet users can correct their entered time. For all other workers, only 

delegated Time Approvers and HRP’s can correct and enter time on behalf of a worker. Time can be 

corrected any time before the pay period ends, and only for a limited time after the pay period is over.  

Return to Top 

Will workers with set work schedules be automatically checked out? 
Workers will not be automatically checked out in Workday. If the worker did not check out, it will display 

as an unmatched time block on the timesheet. A time approver will have the ability to correct the 

worker’s time.  

Return to Top 

What is the intent behind taking away approval access from managers? 
Managers are typically the designated time approver. Workday has specific titles for roles, but since 

there may be some units that have approvers who are not the direct supervisor, it is important to 

distinguish the roles.  

Return to Top 

Will current schedules be valid? 
Yes, none of the schedules will change with the upgrade to Workday. All current schedules from the 

prior system will be imported into Workday. For any new schedules that need to be created, please 

reach out to the Workday team.   

Return to Top 

Can you clock in from a mobile device? 
Current functionality through the Workday Mobile app is not available. However, if a user chooses to log 

in via the browser on their mobile device, the Workday site will allow access to the site as in current 

state.  

Return to Top  

Is there any way to track falsification of time? 
While there is no method to track falsifications of time within the system, workers, managers, and time 

approvers should adhere to the university guidelines on reliable attendance including absenteeism and 

tardiness.   
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Return to Top  

Will an unapproved request that comes before the payroll deadline still be paid out? 
Policy requires that all of your time records be reviewed and approved. If your approver does not check 

your timesheet before the time is reported to Payroll, your approver should work with your local HR 

Partner to approve your records and make any adjustments to errors on your time record. Adjustments 

to pay resulting from errors in Workday will be reflected in a later paycheck. 

Return to Top  

How will managers know which worker requested time off if they are not the designated 

time approver? 
The managing process of time off isn’t changing; typically the manager and time approver should be 

aware of requests approved, or work with Workday Solutions to make the manager the time approver. 

Return to Top 


